
1. ஒளியியல் 
 

 

I.சரியான விடைடயத் ததர்ந்ததடு. 
 

1. ஒளியானது எப்பபாழுதும் _____பெல்லும், இந்தப்பண்பு ______என அழைக்கப்படுகிறது.  

அ) வழளககாட்டில், நிைல்கள் 

ஆ) தநர்த ாை்டில், நிழல் ள்  

இ) கநரக்காட்டில், எதிபராளிப்பு 

ஈ) வழளந்து பின் கநராக, நிைல்கள் 

 

2. ஆடியில்படும் ஒளியானது __________  

அ) ஊடுருவிெ ்பெல்கிறது 

ஆ) எதிதராளிப்பு அடைகிறது  

இ) உட்கவரப்படுகிறது 

ஈ) விலகலழடகிறது 

 

3. __________ பரப்பு ஒளிழய எதிபராளிக்கிறது.  

அ) நீர ்   ஆ) குறுந்தகடு    இ)  ண்ணாடி   ஈ) கல் 

 

4. ஒளி என்பது ஒரு வழக __________  

அ) பபாருள்      ஆ) ஆற்றல்   இ) ஊடகம்   ஈ) துகள் 

 

5. நீங்கள், உங்கள் பிம்பத்ழதப் பளப்பளப்பான பரப்பில் பாரக்்க இயலும், ஆனால் மர 

கமழையின் பரப்பில் பாரக்்க இயலாது, ஏபனனில் __________  

அ) ஒழுங்கான எதிபராளிப்பு, மர கமழையில் நழடபபறுகிறது மற்றும் ஒழுங்கற்ற 

எதிபராளிப்பு பளப்பளப்பான பரப்பில் நழடபபறுகிறது.  

ஆ) ஒழுங் ான. எதிதராளிப்பு, பளபளப்பான பரப்பில் நடைதபறுகிறது மற்றும் 

ஒழுங் ற்ற எதிதராளிப்பு மர தமடையில் நடைதபறுகிறது.  

இ) இரண்டு பரப்புகளிலும், ஒழுங்கான எதிபராளிப்பு நழடபபறுகிறது.  

ஈ) இரண்டு பரப்புகளிலும், ஒழுங்கற்ற எதிபராளிப்பு நழடபபறுகிறது.  
 

6. பின்வருவனவற்றில் எது பகுதி ஒளி ஊடுருவும் பபாருள்? 

 

அ) கண்ணாடி     ஆ) மரம்   இ) நீர ்  ஈ) தம ம்  
 

7. ஒளியானது __________ எதிதராளிப்பு நடைதபறுகிறது. 

அ) எதிபராளிக்கும் பரப்ழப அழடயும் கபாது.  

ஆ) எதிதராளி ்கும் பரப்டப அணுகும்தபாது  

இ) எதிபராளிக்கும் பரப்பின் வழிகய பெல்லும்கபாது  

ஈ) கமற்கூறிய எதுவும் இல்ழல . 

 

8. கீழ் ் ாணும் எப்தபாருள், ஒளிடய நன்கு எதிதராளி ்கும்?  

அ) பிளாஸ்டிக் தட்டு     ஆ) சமதள ஆடி  இ) சுவர ்     ஈ) காகிதம் 

 

9. சிவராைன் ஒரு மீட்டர ் அளவுககாழல, காழல 7 மணிக்கு விழளயாட்டு ழமதானத்தில் 

கநரக்்குத்தாக நிற்க ழவக்கிறான். நண்பகலில் கதான்றும் அளவுககாலின் நிைலானது __________ 

 

அ) ததான்றாது.  

ஆ) காழலயில் கதான்றிய நிைழலவிட நீளமானது மற்றும் நிைல், சூரியனின் 

எதிரத்்திழெயில் கதான்றும்.  
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இ) காழலயில் கதான்றிய நிைழலவிடக் குழறவான நீளம் பகாண்டது மற்றும் நிைல், 

சூரியனின் அகத திழெயில் கதான்றும்.  

ஈ) காழலயில் கதான்றிய நிைழல விடக் குழறவான நீளம் பகாண்டது. 

 
 

10. ஊசித்துழளக்காமிராவில் கதான்றும் பிம்பம் தழலகீைானது, ஏபனனில் ___________ 

அ) ஒளியானது கநரக்்ககாட்டில் பெல்லும்  

ஆ) ஒளிக்கதிரக்ள் துழளயின் வழிகயெ ்பெல்லும்கபாது, தழலகீைாகெ ்பெல்கிறது.  

இ) ஒளிக்கதிரக்ள் துழளயின் வழிகயெ ்பெல்கிறது.  

ஈ) ஒளிக்கதிரக்ள் எதிபராளிக்கப்படுகின்றன. 

 

11.  பின்வரும் எந்தக்கூற்று, நிைல்கள் உருவாக்கத்ழத விளக்குகிறது? 

அ) ஒளி கநரக்காட்டில் பெல்கிறது.  

ஆ) ஒளி ஊடுருவாப் பபாருள் ஒளிழயத் தன் வழிகய அனுமதிப்பதில்ழல. 

இ) எதிபராளிப்பு, கண்ணாடி கபான்ற பரப்புகளில் நழடபபறுகிறது.  

ஈ) இடவல மாற்றம் அழடகிறது.  

  i. அ மற்றும் ஆ  ,   ii. அ மற்றும் ஈ ,  iii. அ மற்றும் இ , iv.அ மட்டும் 

  

II. த ாடிை்ை இைங் டள நிரப்பு . 

 

1. ஒரு ெமதள ஆடியானது உருவாக்கும் பிம்பம் ______ஆகும் (தநரான மாய பிம்பம் ) 

2. ________ எதிபராளிப்பு ஆனது பபாருள்கழளக் காண உதவுகிறது  (ஒளி) 

3. ஒளிக்கதிரக்ள் பளபளப்பான பரப்பின் மீது விழும்கபாது, அழவ __________ அழடகின்றன 

(எதிதராளிப்பு) 

4. சூரிய ஒளியானது, ____ வண்ணங்களின் கலழவ ஆகும் ( பல (ஏழு நிறங்கள் VIBGYOR) 

5. ஒரு பவள்பளாளி ஆனது, ஏழு வண்ணங்களாகப் பிரிழகயழடயும்  நிகை்வு ____ எனப்படும்   

(நிறப்பிரிட ) 

6. ெந்திரன், சூரியனிடமிருந்து ஒளிக்கதிரக்ழள __________ பெய்கிறது. (எதிதராளி ் ) 

7. _____பயன்படுத்தி, சூரிய ஒளியில் அடங்கியுள்ள வண்ணங்கழளப் 

பிரிக்கலாம்  (முப்பை்ை ம்) 

8. பொரபொரப்பான பரப்பின் கமல் ______எதிபராளிப்பு நழடபபறுகிறது. (ஒழுங் ற்ற) 

 

 

III. கீழ் ் ாணும் கூற்று ள் சரியா, தவறா என ஆராய் . கூற்று தவறு எனில்,  சரியான 

கூற்டற எழுது   
 

1. ஆடியின் முன் நிற்கும் கபாது, உன் வலக் ழகயின் பிம்பமும், இடக் ழகயின் பிம்பமும் ஒகர 

மாதிரியாகத் கதாற்றமளிக்கின்றன    சரி 

2. சூரிய ஒளியானது, நீரத்்துளிகளின் மூலம் நிறப்பிரிழக அழடந்து வானவில் கதான்றுகிறது 

சரி 

3. ெமதள ஆடியில் கதான்றும் பிம்பம் இடவலமாற்றம் அழடகிறது. எனகவ பபரிஸ்ககாப்பின் 

மூலம் கதான்றும் பிம்பமும் இடவலமாற்றம் அழடகிறது.  தவறு 

ெமதள ஆடியில் கதான்றும் பிம்பம் இடவலமாற்றம் அழடகிறது. ஆனால் பபரிஸ்ககாப் 

ஒன்றின் மூலம் கிழடக்கக்கூடிய கழடசி பிம்பமானது இடவலமாற்றம் இன்றி கிழடக்கிறது.  

4. சூரிய ஒளிழயக் ககாள்கள் எதிபராளிப்பதன் காரணமாக அதழனக் காண  முடிகிறது  சரி 
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5. புத்தகத்தின் கமற்பரப்பு, ஒளிழய எதிபராளிப்பதால் புத்தகத்ழத நாம் காண முடிகிறது. சரி 

6. ஊசித்துழளக் காமிராவில் கதான்றும் பிம்பம், கநரம்ாறு பிம்பம் ஆகும்.  சரி  

7. ஊசித்துழளக் காமிராவில் கதான்றும் பிம்பத்தின் அளவும், பபாருளின் அளவும் ெமம் தவறு    

ஊசித்துழள காமிராவில் கதான்றும் பிம்பத்தின் அளவு பபாருளின் அளவிலிருந்து 

மாறுபடலாம்.  

8. ெமதள ஆடியில் கதான்றும் பிம்பம் தழலகீை் மாற்றம் அழடகிறது. தவறு  

 ெமதள ஆடியில் கதான்றும் பிம்பமானது தழலகீை் மாற்றம் அழடவதில்ழல 

 9. ெமதள ஆடி, ஒளி ஊடுருவாத ஒரு பபாருள் ஆகும். சரி  

10.  ஒரு பபாருளின் நிைல், பபாருள் இருக்கும் அகத பக்கத்தில் அழமயும்.  தவறு 

ஒரு பபாருளின் நிைலானது ஒளி மூலம் இருக்கும் திழெக்கு எதிரத்ிழெயில் உருவாகும். 

 11. நம்ழமெச்ுற்றி இருக்கும் பபாருள்கழள, ஒளியின் ஒழுங்கான எதிபராளிப்பின் மூலகம 

காண்கிகறாம்.    சரி 

12. ஒரு பவள்பளாளி ஆனது, முப்பட்டகம் வழிகய பெல்லும்கபாது, அது  ஏழு வண்ணங்களாகப் 

பிரிழக அழடகிறது.   சரி 

 
 

IV. தபாருத்து .  

1. கநரக்காட்டுப் பண்பு  -   முதன்ழம ஒளிமூலம் 

2. ெமதள ஆடி –    ஒளிராப் பபாருள்  

3. மின்மினிப்பூெச்ி –    பபரிஸ்ககாப் 

4. நிலா –     ஊசித்துழளக் காமிரா  

5. அகன்ற ஒளி மூலம் –   நிறப்பட்ழட  

6. ஒழுங்கான எதிபராலிப்பு –   ஒளிரும் பபாருள் 

7. சூரியன் –     புறநிைல்  

8. ஏழு வண்ணங்கள் –    பளப்பளப்பான பரப்பு  

விடை ள் : 

1. கநரக்காட்டுப் பண்பு  -    ஊசித்துடள ்  ாமிரா  

2. ெமதள ஆடி –    தபரிஸ்த ாப்  

3. மின்மினிப்பூெச்ி –    ஒளிரும் தபாருள் 

4. நிலா –     ஒளிராப் தபாருள் 

5. அகன்ற ஒளி மூலம் –    புறநிழல்  

6. ஒழுங்கான எதிபராலிப்பு –   பளப்பளப்பான பரப்பு 

7. சூரியன் –     முதன்டம ஒளிமூலம் 

8. ஏழு வண்ணங்கள் –    நிறப்பை்டை 

 
 
 

V. சுரு ் மா  விடையளி  
 

1. எதிபராளிப்பு விதிகழள, படத்துடன் கூறுக. 

 

விதி ள்  
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✓ படு ககாணமும் எதிபராளிப்பு ககாணமும் ெமம் . 

✓ படுகதிர,்எதிபராளிப்பு கதிர ்மற்றும் குத்து ககாடு ஆகிய மூன்றும் ஒகர தளத்தில் 

அழமயும். 

 

 
 
 

2. படத்தில் ஒரு பபன்சில், ஓர ்ஆடியில் கமகல இருக்கும் நிழலழயக் காட்டுகிறது? எனில் 

3.  

 

 
 
 

அ) ஆடியில் கதான்றும் பபன்சிலின் பிம்பத்ழத வழரக. 

 

 

 
 

ஆ) பபன்சிலிருந்து வரும் ஒளிக்கதிரக்ள் எவ்வாறு ஆடியில் எதிபராளிக்கப்பட்டு, 

கண்ணிற்கு அதன் பிம்பம் கிழடக்கிறது படம் வழரந்து காட்க. 

 

 

 

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID: padasalai.net@gmail.com

w
w

w
.P

ad
as

al
ai

.N
et

w
w

w
.P

ad
as

al
ai

.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


 
 

4. ஒருவர,் தன் முன்னால் ஆடியில் ஒரு மரத்தின் பிம்பத்ழத 3.5 மீட்டர ் பதாழலவில் 

இருந்து பாரக்ிறார.் மரம், அவர ் கண்களிலிருந்து 0.5 மீட்டர ் பதாழலவில் பின்னால் 

இருக்கிறது, எனில் மரத்திற்கும் அவர ்கண்ணிற்கும் இழடகய உள்ள பதாழலவு என்ன? 

பபாருழளக் காண நமக்கு அவசியமான காரணிகள் யாழவ? 

 

விடை : 

 

 
 

 மனிதனுக்கும், ஆடிக்கும் இழடகய உள்ள பதாழலவு = 3.5m  

மனிதனுக்கும், மரத்திற்கும் இழடகய உள்ள பதாழலவு = 0.5m  

மரத்திற்கும் கண்ணாடிக்கும் இழடகய பமாத்த பதாழலவு = 0.5 + 3.5 = 4m  

மனிதனுக்கும் ஆடிக்கும் இழடகய உள்ள பதாழலவு + மரத்திற்கும், கண்ணாடிக்கும் 

இழடகய உள்ள பதழலவு   = 3.5m + 4m =  7.5m 

 
 

5. ஒளிரும் பபாருள்கள் என்றால் என்ன?  
 

தாமாககவ ஒளிரக்கூடிய பபாருட்கள் ஒளிரும் பபாருள்கள் எனப்படும். 

(எ.கா) சூரிய ஒளி, மின்ொர பல்பு 

 

5. நிலா ஓர ்ஒளிரும் பபாருளா? காரணம் கூறு. 

• ஆம்.. சூரியனிடமிருந்து ஒளிழயப் பபற்று பூமிக்கு பிரதிபலிக்கிறது 

• ஆனால் ெந்திரன் தாமாககவ ஒளிழய உமிைாது.  
 

6. ஒளிழய உட்கவரும் பண்பிழனப் பபாருத்து, பபாருள்களின் மூன்று வழககள் யாழவ? 

• ஒளி ஊடுருவும் பபாருள்கள் (எ. ா) தூய நீர ்  

• பகுதியாக  ஒளி ஊடுருவும் பபாருள்கள் (எ. ா) பொரபொரப்பான கண்ணாடி  

• ஒளி ஊடுருவாப் பபாருள்கள் (எ. ா) கல்,கட்ழட  

 

7 .நிைல்களின் பகுதிகள் யாழவ? 

• கரு நிைல் ,  • புற நிைல் 

 

8. நிைல்களின் பண்புகள் யாழவ? 

 

➢ ஒளி ஊடுருவாப் பபாருட்ககள நிைல்கழள உருவாக்குகின்றன.  

➢ நிைல்கள் எப்பபாழுதும் ஒளிமூலத்திற்கு எதிரத்் திழெயில் உருவாகும்.  

➢ பபாருளின் நிறம் எதுவானாலும், நிைல் கருழமயாககவ இருக்கும்.  

➢ ஒளி மூலம், ஒளி ஊடுருவாப்பபாருள் மற்றும் நிைல் ஆகிய மூன்றும் ஒகர 

கநரக்்ககாட்டில் அழமயும்.  

➢ நிைலின் அளவு  ஒளிமூலம் பபாருள் மற்றும் திழரக்கிழடகய உள்ள பதாழலழவ 

ொரந்்தது  
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9. ெமதள ஆடி என்றால் என்ன?  

• ெமதள ஆடி என்பது, எதிபராளிப்பின் மூலம் பிம்பத்ழத உருவாக்கும் வைவைப்பான ஒரு 

ெமதள பரப்பு ஆகும்.  

• தன் முன் கதான்றும் பபாருளின் பிம்பத்ழத உருவாக்கும். 

 

10. முப்பட்டகம் என்றால் என்ன? 

முப்பட்டகம் என்பது இரண்டு ெமதளப்பரப்புகளுக்கு இழடகய குறுங்ககாணம் பகாண்ட 

முழுவதும் கண்ணாடி அல்லது பிளாஸ்டிக்கினால் உருவாக்கப்பட்ட பபாருள் ஆகும்.  
 

11. கண்ணுறு ஒளி என்றால் என்ன? 

 

மனிதக் கண்ணால் காணக்கூடிய  பல்கவறு நிறங்கழள பகாண்டது கண்ணுறு ஒளி 

ஆகும். இதன் வரம்பு 400 nm  முதல் 800 nm வரர இருக்கும்.  
 

12. கீை்க்காணும் பபாருள்கழள அட்டவழணயில் ெரியான இடத்தில் நிரப்புக. 

(நை்சத்திரம், தசங் ல் சுவர், தாவரங் ள்,  ண்ணாடி த ாள் ள், மின்பல்பு, எரியும்   

தமழுகுவத்தி)  

 

ஒளி மூலங் ள்  

நட்ெத்திரம் 

ககாள்கள் 

மின்பல்பு 

எரியும் பமழுகுவத்தி 

 

ஒளிடய  எதிதராளிப்படவ  

பெங்கல் சுவர ்

தாவரங்கள் 

கண்ணாடி 

 
 

13. 1 மீட்டர ்45 பெ.மீ உயரமுழடய ஒரு சிறுவன், நீளமான ஓர ்ஆடியிலிருந்து 2 மீட்டர ்

பதாழலவில் நிற்கிறான், எனில் பின்வருவனவற்ழற நிரப்புக.  
 

அ) சிறுவன் மற்றும் அவன் பிம்பத்திற்கும் இழடகய உள்ள பதாழலவு ____ (4 மீ ) 

ஆடியிலிருந்து சிறுவன் நிற்கும் தூரம் = 2 மீ 

எனகவ சிறுவன் மற்றும் அவன் பிம்பத்திற்கும் உள்ள பதாழலவு =  

        சிறுவனிடமிருந்து கண்ணாடியின் தூரம் + கண்ணாடிக்கும் பிம்பத்திற்கும் உள்ள 

தூரம்.   = 2 மீ + 2 மீ = 4 மீ 

ஆ) ஆடியில் ததான்றும் சிறுவனுடைய பிம்பத்தின் உயரம் ______(1மீ 45 தச.மீ ஆகும்).  

இ) சிறுவன் 1 மீட்டர ்பதாழலவு ஆடிழய கநாக்கிெ ்பென்றால், ஆடிக்கும், பிம்பத்திற்கும் 

இழடகய உள்ள பதாழலவு __________  ( 1மீ ஆகும்) 

. 

14. ஏகதனும் ஒரு பபாருள் ஒன்ழறயும் ஊசித்துழளக் காமிரா ஒன்று உருவாக்கும் 

அப்பபாருளின் பிம்பத்ழதயும் வழரக. 
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15. அவெர கால ஊரத்ிகளில் (AMBULANCE) என்ற வாரத்்ழத வல, இடமாக மாற்றி  

    எழுதப்பட்டிருப்பதன் காரணம் என்ன?        

 
 

• ெமதள ஆடியின் இடவலமாற்ற பண்பு இங்கு  பயன்படுத்தப்படுகிறது.  

• ஊரத்ியில் வலமிருந்து இடமாக எழுதப்பட்ட ECNALUBMA  வாரத்்ழதயின் எழுத்துகள் 

முன்னால் பெல்லும் வாகனத்தின் கண்ணாடியில் 'AMBULANCE' என கநராகத் பதரியும். 

 

16. ஆடியில் கதான்றும் சில பபரிய ஆங்கில எழுத்துகளின், பிம்பங்கள் மாறாமல் 

இருக்கின்றன. இதர பபரிய ஆங்கில எழுத்துகளின் பிம்பங்கள் மாற்றம் அழடகின்றன. 

இதற்குக் காரணம் என்ன? விளக்குக.  
 

• A, H, I, M, O, T, U, V, W, X மற்றும் Y கபான்ற 11 எழுத்துகளின் பிம்பங்கள் மாற்றம் 

அழடகின்றன. இதற்கு ‘ெமெச்ீர ்தன்ழமகய' காரணமாகும்.  
 

• மற்ற எழுத்துக்களின் (B, C, D, E, F, G, J, K, L, N, P, Q, R, S மற்றும் Z) பிம்பங்கள் மாறாமல் 

இருக்கின்றன. இதற்கு ‘இடவல மாற்றம்’ காரணமாகும். 

 

17. M1 மற்றும் M2 என்ற இரு ஒன்று ்த ான்று தசங்குத்தான சமதள ஆடி ள் பைத்தில் 

 ாை்டியுள்ளவாறு டவ ் ப்பை்டுள்ளன. AB என்ற  திர் M1 என்ற சமதள ஆடிதயாடு 45° 

படுத ாணத்டத ஏற்படுத்துகிறது.  
 
                                                                                                               
 
                                                                                                   answer 
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அ. _____ ____ ஆகியழவ எதிபராளிப்புக் கதிரக்ள் ஆகும். (BC, CD ) 
 

ஆ. __________ __________  ஆகியழவ படுகதிரக்ள் ஆகும்.   (AB, BC ) 
 

இ. BC என்ற கதிர ்ஏற்படுத்தும் படுககாணம் என்ன?  45°  

ஈ. CD என்ற கதிர ்ஏற்படுத்தும் எதிபராளிப்புக் ககாணம் என்ன?   45° 
 

18. ராைன், கடிகார பிம்பங்களின் படங்கழளக் பகாண்டு விழளயாடுகிறான். அவன் தன் 

அழறயில் உள்ள கடிகாரத்ழதப் பாரக்்கிறான். அது 1:40 எனக்காட்டுகிறது. பின்வரும் 

படங்களில், ராைன் கடிகார மற்றும் அதன் கண்ணாடிப் பிம்பத்தில் கடிகார முட்கழள எவ்வாறு 

வழரந்திருப்பான்? 

 

                      answer        
 

 

 

 19. ஒளியின் எதிபராளிப்பு என்றால் என்ன? 

 பபாருளின் கமற்பரப்ழபயும் அழடந்த பிறகு, ஒளி கதிரக்ள் மீண்டு வருவது 

ஒளியின் எதிபராளிப்பு எனப்படும்.  
 

20. ஓர ்ஒளிக்கதிர ்50° ககாணத்தில் ஒரு ெமதள ஆடியில் விழுகிறது எனில் 

எதிபராளிப்புக்ககாணம் என்ன?  
 

படுககாணத்தின் மதிப்பு = 90° - 50° = 40° (∠i)  

ஒளி எதிபராளிப்பு விதியின்படி, படுககாணமும், எதிபராளிப்புக் ககாணமும் 

ெமம். 

     i = r 

          ∠i = 40° ∠r = 40°  

எனகவ எதிபராளிப்புக்ககாணம்   = 40° ஆகும்.  
 

21. ெமதள ஆடியில் இடவல மாற்றம் பற்றி நீவிர ்அறிவது என்ன?  
 

ெமதள ஆடியின் இடவல மாற்றப் பண்பின் காரணமாக ஆங்கில எழுத்து 'b' ஆனது 'd' 

கபான்று பதரியும்.  
 

22. பவள்பளாளியின் நிறத்பதாகுப்ழப எவ்வாறு பபறலாம்? 

 

✓ ஒரு பவள்பளாளியானது முப்பட்டகத்தின் வழிகய பெல்லும்கபாது  ஏழு 

வண்ணங்களாக பிரியும். நிகை்வு நிறப்பிரிழக ஆகும்.  

✓ இதில் பபறப்படும் நிறங்கள் நிறத்பதாகுப்பு எனப்படும். 

 

23. நியூட்டன் வட்டிழன கவகமாகெ ்சுைற்றும் கபாது, ஏன் அது பவண்ழம நிறத்துடன் 

கதாற்றமளிக்கிறது?  
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➢ நியூட்டன் வட்டிழன அதன் ழமயம் வழிகயெ ்பெல்லும் அெச்ிழனப் பபாருத்து 

கவகமாகெ ்சுைற்றும் கபாது, நம் கண்ணின் பரட்டினா பவண்ழம நிறத்ழத 

உணரத்்துகிறது.  

➢ நியூட்டன் வட்டு மூலம், பவண்ழம நிறம், ஏழு வண்ணங்கழள (VIBGYOR) உள்ளடக்கியது 

என அறிய முடிகிறது.  

 
 

24. நிைல் என்றால் என்ன? நிைழல உருவாக்க கதழவயான பபாருள்கள் யாழவ?  
 

✓ ஒளி ஊடுருவாப் பபாருட்கள் , தன் வழிகய ஒளிழய பெல்ல அனுமதிப்பதில்ழல . 

அதனால் நிைல் உருவாகிறது.  

✓ ஒளிமூலம் , ஒளி ஊடுருவாப் பபாருள், திழர ஆகியழவ. 

 

VI. பின்வரும் வினா ் ளு ்கு விரிவா  விடையளி.  
 

1. ஒழுங்கான மற்றும் ஒழுங்கற்ற எதிபராளிப்பு என்றால் என்ன? படத்துடன் விவரி.  
 

ஒழுங்கான எதிபராளிப்பு :  

➢  பரப்பு வைவைப்பாக மற்றும் ெமதளமாக இருப்பின் ஒழுங்கான எதிபராளிப்பு 

நழடபபறும்.  

➢ படுகதிரக்ள் இழணகதிரக்ளாகப் பரப்பின் கமல் விழுந்து இழணகதிரக்ளாககவ 

எதிபராளிக்கப்படுகின்றன. 

 

 

 
 

 

ஒழுங் ற்ற எதிதராளிப்பு :  
 

✓ பரப்பு பொரபொரப்பாக இருப்பின் ஒழுங்கற்ற எதிபராளிப்பு நழடபபறும்  

✓ படுகதிரக்ள் இழணகதிரக்ளாகப் பரப்பின் கமல் விழுந்து எதிபராளிப்பிற்குப் பின் 

பவவ்கவறு திழெயில் பெல்கின்றன.  
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2. ஒளிரும் மற்றும் ஒளிரா மூலங்கள் இவற்றிற்கிழடயான கவறுபாட்ழடக் கூறுக. 

ஒவ்பவான்றிற்கும் ஓர ்எடுத்துக்காட்டு தருக.  
 

ஒளிரும் தபாருள் ள்  

ஒளிரும் பபாருள்கள் அவற்றின் பொந்த ஒளிழய பவளிபடுத்தும் பபாருள்  

(எ.கா) பமழுகுவரத்்தி, பல்பு, நட்ெத்திரங்கள், ெந்திரன்  

ஒளிரா தபாருள் ள் 

ஒளிராத பபாருள்கள் ஒளிரும் உடல்களிலிருந்து  ஒளிழயப் பிரதிபலிக்கும் பபாருள்கள் 

(எ.கா) மனிதன், தாவரம், புத்தகம்  

 

3. அன்றாட வாை்வில் நீ காணும் ஒளியின் கநரக்்ககாட்டு பண்பு நிகை்வுகள் இரண்டிழன 

கூறுக.  

➢ மரங்களின் கிழளகளின் வழிகய சூரிய ஒளி கநராக பெல்லுதல்  

➢ சிபமண்ட் கிரிலின், சிறு துழளகளின் வழிகய சூரிய ஒளி கநராக பெல்லுதல். 

➢ கலெர ்மற்றும் டாரெ் ்விளக்கின் ஒளி கநராக பெல்லுதல்  

 

4. எதிபராளிப்பு மற்றும் நிைல் - கவறுபடுத்துக.  

 

எதிதராளிப்பு 

1.ஒளியானது கநர ்ககாட்டில் பென்று பபாருள் மீது பட்டு மீண்டும் திரும்பி பெல்வது ஆகும். 

2.எதிபராளிப்பு கதிழர காண முடியும்  

3. பபாருளின் பரப்பு முக்கிய பங்கு வகிக்கிறது . 

 

நிழல் 

1. ஒளி ஊடுருவாப் பபாருள் தன் வழிகய ஒளி பெல்ல அனுமதிக்கதால் ஏற்படுவது நிைல்  

2. ஒளிழய காண முடியாது   

3. ஒளியின் உட்புகும் திறன் முக்கிய பங்கு வகிக்கிறது. 

 

5. ெமதள ஆடியில் கதான்றும் பிம்பத்தின் பண்புகழளக் கூறுக.  
 

➢ பிம்பம் கநரான பமய் பிம்பம் ஆகும்.  

➢ ஆடியில் கதான்றும் பிம்பமும் பபாருளும் ஒகர அளவில் இருக்கும்.  

➢ ஆடியிலிருந்து, பபாருளின்  பதாழலவும் பிம்பத்தின் பதாழலவும் ெமமாக இருக்கும்  

➢ ஆடியில்  கதான்றும் பிம்பம் இடவல மாற்றம் அழடயும்..  

 

6. பின்வரும் படங்களின் மூலம் நீவீர ்அறிவது என்ன? 

 

                         
 

 ஒளியானது கநரக்காட்டில் பெல்லும்  

 ஒளியானது தாகன வழளந்து பெல்லாது  

 இதுகவ ஒளியின் கநரக்காட்டுப் பண்பு எனப்படும்  

www.Padasalai.Net                                                  www.TrbTnpsc.com
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 B படமானது ஒளியின்  கநரக்காட்டுப் இப்பண்பிழன விளக்குகிறது.  

 படம் A-ல் ஒளி  வழளகிறது. பெல்கிறது இந்த பண்பு ஒளியில் நழடபபறாது.  

 

பின்வருவனவற்ழற வழரயறுக்க.  
 

i) படு திர்   ii) எதிதராளிப்பு ்  திர்   iii) குத்து ்த ாடு    iv) படுத ாணம் 

 

i) படு திர் :  

எதிபராளிக்கும் பரப்பில் படும் ஒளிக்கதிர ்படுகதிர ்எனப்படும்.  

ii) எதிதராளிப்பு ்  திர் : 

படுகதிர ்எதிபராளிக்கும் பரப்பில் பட்டு எதிபராளித்து வருவது.ஆகும். 

iii) குத்து ்த ாடு :   

 எதிபராளிக்கும் பரப்பிற்குெ ்பெங்குத்தாக வழரயப்படும் ககாடு குத்துக்ககாடு எனப்படும்.  

iv) படுத ாணம் : 

படுகதிரக்்கும் குத்துக்ககாட்டிற்கும் இழடகய உள்ள ககாணம் படுககாணம் எனப்படும்  

 

8. ெமதள ஆடியில் கதான்றும் பிம்பங்கழள ஊசித்துழளக் காமிரா காமிரா உருவாக்கும் 

பிம்பங்ககளாடு ஒப்பிடுக.  

 

ஊசித்துடள ்  ாமிராவில் ததான்றும் பிம்பம் 

1. பமய் பிம்பம் 

2. பிம்பத்தின் அளவு பபாருளின் அளவுடன் ஒப்பிடும்கபாது மாறுபடலாம்  

3. தழலகீை் பிம்பம் 

சமதள ஆடியில் ததான்றும் பிம்பம் 

1. மாய பிம்பம் 

2. பிம்பம் மற்றும் பபாருளின் அளவு ெமம்  

3. கநரான பிம்பம் 

 
Prepared by Subbiah Palaniyandi 
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2.அண்டம் மற்றும் விண்வெளி 

 

I. சரியான விடடடயத் ததர்ந்வதடுக்கவும்  

1. நிலவானது பூமியை ஒரு சுற்று சுற்றி வர __________ நாட்களாகும்.  

அ) 25     ஆ) 26    இ) 27   ஈ) 28  

2. இன்யறை நாளில் காரத்்தியக நட்சத்தித்திற்கு அருகில் நிலவு இருந்தால் 27 நாட்கள் கழிந்து 

நிலவானது __________ நட்சத்திரத்திற்கு அருகில் இருக்கும்.  

அ) பரணி ஆ) காரத்்தியக  இ) ரராஹிணி  ஈ) அஸ்வினி 

3. __________ததாயல ரநாக்கியைக் கண்டறிந்தார.்  

அ) ஹான் லிப்வபர்தே  

ஆ) கலிலிரைா  

இ) நிக்ரகாலஸ் காப்பரந்ிக்கஸ்  

ஈ) தாலமி  

4. அரனக இளம் நட்சத்திரங்கயளக் தகாண்ட விண்மீன் திரளுக்கு __________ என்று தபைர.்  

அ) நீள்வட்ட விண்மீன் திரள்  

ஆ) ஒழுங்கற்ற விண்மீன் திரள்  

இ) குழுக்கள் 

ஈ) சுருள் விண்மீன் திரள் 

5. __________ துயணக்ரகாயள நிறுவிைவுடன் ISRO 4 டன் எயடயுயடை துயணக்ரகாள்கயள ஏவும் 

திறன் தபறுகிறது.  

அ) GSAT- 13  ஆ) GSAT- 14   இ) GSAT-17  ஈ) GSAT- 19 

II. தகாடிட்ட இடத்டத நிரப்பவும் 

 

1. வளரப்ியற என்பது ____ (ெளரத்ல் அல்லது வெளிசச்த்தில் விரிெடடதல்) 

2. சூரிையமைக் தகாள்யகயை முன் தமாழிந்தவர ்____  (நிக்தகாலஸ் தகாப்பர் நிக்கஸ்) 

3. அண்டத்தின் ஆதியைக் குறித்துக் கூறும் மாதிரி _____ஆகும்.  (வபரு வெடிப்பு தகாட்பாடு) 

4. ஆகாைத்தின் தபரும்பகுதியை அடக்கியுள்ள விண்மீன் மண்டலம்_____ஆகும்(உரச்ா தமஜர்) 

5. இந்திைா ஏவிை முதல் ஏவுகயண _____ஆகும்.  (ஆர்யபட்டா) 

 

III. சரிைா - தவறா. தவதறனில் காரணம் கூறவும் 

1.முழுநிலவு நாளன்று சூரிைன் ரமற்கில் மயறயும்தபாழுது நிலவு ரமற்கில் ரதான்றும்  தெறு  

முழு நிலவு நாளில் சூரிைன் ரமற்கில் மயறயும் தபாழுது  நிலவு கிழக்கில் உதிக்கிறது.  
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2. நிலவானது பாதியைவிடக் குயறவாக ஒளிரும் நியலக்கு பியறநிலவு என்று தபைர.் சரி 

3. கலிலிரைா புவி யமைக் தகாள்யகயை வழி தமாழிந்தார.் தெறு  

சூரிை யமைக் ரகாட்பாட்டிற்கு ஆதரவாக ஆதாரங்கயள அளித்தார.்  

4. நமது பால்தவளித் திரளானது நீள்வட்ட விண்மீன் திரள் ஆகும். தெறு  

: நமது பால்தவளித் திரளானது சுருள் விண்மீன் திரள் ஆகும்.  

5. நமது சூரிைக் குடும்பத்திலுள்ள தவள்ளிக் ரகாளுக்கு நிலவு கியடைது. சரி 

 

IV. வபாருத்துக.  

1. ரராகினி – .    GSLV–Mark III 

2. GSAT-14 –    GSLV Mark III M1 

3. GSAT-19 –     SLV-3  

4. சந்த்ரைான்–2 –   PSLV-XL- C25 

5. மங்கள்ைான் –    GSLV-D5 

 

விடடகள்  

1. ரராகினி –    SLV-3  

2. GSAT-14 –    GSLV-D5  

3. GSAT-19 –    GSLV Mark III M1 

4. சந்த்ரைான்–2 –  GSLV–Mark III 

        5. மங்கள்ைான் –   PSLV-XL- C25 

 

V. ஒப்புடம தருக  

 

1.பயழை நட்சத்திரங்கள் : நீள்வட்ட விண்மீன்திரள் :  

  புது நட்சத்திரங்கள் : _____ (சுருள் விண்மீன்திரள்கள்) 

2. அருகிலுள்ள விண்மீன் திரள் : ஆண்ட்ரதமடா   : 

  அருகிலுள்ள நட்சத்திரம் : _____ (ஆல்ஃபா வசன்டாரி) 

 

VI. மிகக் குறுகிய விடடயளிக்கவும் 

 

1. __________ என்ற வாரத்்யத நிலவானது நிலவு பாதியை விடக் குயறவாக ஒளிரும் நியல ஆகும். 

(பியற நிலவு / கூனல் நிலவு)     (பிடற நிலவு) 

2. __________ மற்றும் __________ ரகாள்கள் நடு இரவில் ரதான்றாது. (புதன் மற்றும் வெள்ளி) 

3. சூரிையனச ்சுற்றி வர தசவ்வாை் எடுத்துக் தகாள்ளும் காலம்  (687 நாட்கள்) 

4. தவள்ளியின் அளவு எந்த கட்டத்தில் மிகச ்சிறிைதாக இருக்கும்?  (பிடற நிலவு) 

5.தபருதவடிப்புக் ரகாட்பாட்டிற்கான ஒரரதைாரு சான்று (காஸ்மிக்  நுண்ணடல  பின்னணி 

(CMB) ) 

6. அதிகளவு வாயு மற்றும் துகள்கயளக் தகாண்ட விண்மீன்திரள் _____ (சுருள் விண்மீன் ) 

7. உலகின் முதல் ஏவு வாகனத்யத ஏவிை நாடு எது?   ரே்யா (ஸ்புட்னிக்-1)  
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VII. குறுகிய விடடயளி  

1. நீள்வட்ட மாதிரி என்றால் என்ன? 

பூமி மற்றும் சூரிைனின் சுழற்சி பற்றிை குழப்பமான நிகழ்வுகயள விளக்க வானிைல் 

அறிஞ்கள்  புவியமைக் ரகாட்பாட்டில் ஒரு மாற்றத்தியன முன்தமாழிந்தனர.் இது ‘நீள்வட்ட 

மாதிரி' என அயழக்கப்படுகிறது.  

 

2. நான்கு வயகைான விண்மீன் திரள்களின் தபைரக்யளக் கூறுக.  

 

• சுருள் விண்மீன்திரள்கள், • நீள்வட்ட விண்மீன்திரள்கள் ,  

• ஒழுங்கற்ற விண்மீன்திரள்கள், • ரகாடிட்ட சுருள் விண்மீன்திரள்கள்  

 

3. விண்மீன் மண்டலம் என்றால் என்ன? 

இரவு வானத்தில் காணப்படும் கண்களால் காணக்கூடிை  நட்சத்திரங்களின் அயமப்பு 

'விண்மீன் மண்டலம்' எனப்படும்.எ .கா உரச்ா தமஜர்). .  

 

4. PSLV மற்றும் GSLV யின் விரிவாக்கம் தருக.  

 

PSLV - துருவ தசைற்யகக்ரகாள் தவளியீட்டு வாகனம்  

GSLV - ஜிரைாசின்க்ரரானஸ் தசைற்யகக்ரகாள் ஏவுதல் வாகனம். 

 

VIII. விரிொன விடடயளி  

1. வெள்ளியின் ெளர் மற்றும் ததய் கட்டங்கடளக் குறித்து விளக்குக.  

➢ நிலயவப்ரபாலரவ தவள்ளியும் பல கட்டங்கயளக்தகாண்டுள்ளது.  

➢ தவள்ளியின் வளர ்மற்றும் ரதை் கட்டங்கள் சூரிை யமை தகாள்யகயை 

நிருபிக்கின்றது.  

➢ தவள்ளி  கிப்பஸ் கட்டத்தில் இருந்தரபாது அதன் அளவு சிறிைதாக இருந்தது.  

➢ தமல்லிை பியறரபால் இருந்தரபாது அதன் அளவு பலமடங்கு   அதிகமானது. 

➢ தவள்ளி நீள் வட்டத்தில் சுற்றி வருகிறது. 

➢ தவள்ளிைானது சூரிையனச ்சுற்றிக் தகாண்டிருந்தாலும், நள்ளிரவு வானத்தில் 

அதயனக் காண முடிைாது. 

➢ தவள்ளி பூமிக்கு அருகில் வரும்ரபாது அது சூரிைனுக்கு எதிரப்்பக்கத்தில் இருந்தயத 

விடப் தபைரிைதாகவும், பிரகாசமாகவும் இருக்கும்.  

➢ தவள்ளி பூமியைச ்சுற்றிவருரமைானால்  நாம்  தவள்ளியின் குமிழ் பியறயைக் 

காணமுடிைாது , 

➢ தவள்ளி, சூரிையனச ்சுற்றி வந்தால் மட்டுரம காணமுடியும் .  
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2. விண்மீன் மண்டலத்டதக் குறித்து சிறு குறிப்பு ெடரக.  

 

➢ இரவு வானத்தில் காணப்படும் கண்களால் காணக்கூடிை  நட்சத்திரங்களின் அயமப்பு 

'விண்மீன் மண்டலம்' என அயழக்கப்படுகிறது.  

➢ சரவ்ரதச வானிைல் அயமப்பு  88 விண்மீன் மண்டலங்கயள வயகப்படுத்தியுள்ளது.  

➢ உரச்ாரமஜர ்(சப்தரிஷிமண்டலம்) தபரிை விண்மீன் மண்டலம் ஆகும். அது வானத்தின் 

தபரும் பகுதியை உள்ளடக்கிைது.  

➢ உரச்ாரமஜர ்மண்டலத்தின் சிறப்பு ஏழு பிரகாசமான நட்சத்திரங்களின் தபரிை குவயள 

(இந்திை வானிைலில் ஏழு துறவிகள்) என அயழக்கப்படும் ஒரு குழுவாகும்.  

➢ வட வானத்திலுள்ள உரச்ா யமனர ் இலத்தீன் தமாழியில் 'சிறிை கரடி' என 

தபாருள்படும்.  

➢ துருவ நட்சத்திரம் (ரபாலாரிஸ்) சிறிை டிப்பர ் (ஏழு நட்சத்திரம் தகாண்ட குழு) 

ரபான்றயவ இம்மண்டலத்தில் உள்ளது  

➢ ஓரிைன் விண்மீன் மண்டலம் 81 விண்மீன்கயள உள்ளடக்கிைது. இதில் 10 தவிர 

ஏயனைவற்யற தவற்று கண்களால் காண இைலாது.  

➢ பல்ரவறு விண்மீன்கள் ஆண்டு முழுவதும் தவவ்ரவறு ரநரங்களில் வானத்தில் 

காணப்படுகின்றன. சூரிையனச ்சுற்றி பூமியின் சுழற்சி காரணமாக இது  நிகழ்கிறது.  

➢ நட்சத்திரங்கள் ஈரப்்பு வியசைால் பியணக்கப்பட்டு ஓர ்அயமப்பாக உள்ளன. 

➢ விண்மீன் மண்டலங்கள் தவறும் ஒளியிைல் ரதாற்றரம. 

 

 

 

IX. உயரிய சிந்தடனக் தகள்வி  

1. நீலனும் மாலாவும் நமது அண்டத்தியனக் குறித்த ஒரு உயரைாடலில் உள்ளனர.் நமது பூமி 

மட்டும் தான் உயிர ் வாழத்தகுந்த ஒரர ரகாள் என நீலன் கூறுகிறான். ஆனால் சில 

விளக்கங்கயளக் கூறி மாலா அவனது கருத்தியன எதிரக்்கிறாள். மாலா என்ன விவாதம் 

தசை்திருப்பாள். நீ மாலாயவ ஆதரிக்கிறாைா? உனது நியலயை நிைாைப்படுத்து.  

நீலன் : நமது பூமி மட்டும்தான் உயிர ்வாழத்தகுந்த ஒரர ரகாள்.  
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மாலா :  

➢ தற்ரபாது ரவறு நட்சத்திரங்கயளச ் சுற்றியும் தவளிக்ரகாள்கள் இருப்பதாக 

கண்டறிைப்பட்டுள்ளன. இதிலிருந்து சூரிையன சுற்றி மட்டுமல்லாமல், பிரபஞ்சம் 

முழுவதும் இந்தக்கிரக அயமப்புகள் இருப்பது நிரூபணம் ஆகிறது.  

➢ ைாருக்குத் ததரியும்? அந்த கிரகங்களில் எதிலாவது வாழ்க்யக இருக்கலாம், அதிலும் 

சிலவற்றில் மனிதயனப் ரபான்ற பகுத்தறிவுள்ள உயிர ்வாழ்வதாக இருக்கலாம்.  

➢ நாம் பிரபஞ்சத்யதப் பாரத்்து விைப்புற்று, ஆராை்சச்ி தசை்வது ரபால் அவரக்ளும் 

ஆராை்சச்ி தசை்ைலாம்.  

➢ எதிரக்ாலத்தில் நாம் அவரக்யளச ் சந்திக்கும் தபாழுது அந்தக் கணம் எவ்வளவு 

அற்புதமானதாகவும், உற்சாகமானதாகவும் இருக்கும்! 

குறிப்பு : மாலாவின் கூற்றுப்படி, ஆராை்சச்ிகள் பல ரமற்தகாள்ளப்பட்டு வருகின்றன. 

இருப்பினும் விஞ்ஞானிகளின் தற்ரபாயதை கண்டுபிடிப்பில் பூமி மட்டுரம உயிரிகள் வாழ 

ஏதுவான ரகாளாக உள்ளது.  

சூரியன் : பூமியின் இருப்பிடம், தட்ப தவப்ப நியல, புறஊதாக்கதிரக்ளின் பாதுகாப்பு, 

புவியீரப்்பு முடுக்கம் ரபான்ற பல காரணங்களால் பூமி ரகாள் மட்டுரம தற்ரபாது உயிர ்வாழத் 

தகுந்த ஒரர ரகாள் ஆகும். 

 

Prepared by Subbiah Palaniyandi 
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3 . பலபடி வேதியியல் 

 

I. சரியான விடைடயத் வதர்ந்ததடுத்து எழுதுக.  

 

1. மனிதனால் உருோக்கப்பை்ை முதல் இடை __________ ஆகும்.  

அ) நைலான்    ஆ) பாலியஸ்டர ்   இ) வரயான்      ஈ) பஞ்சு 

 

2. ேலுோன இடை __________ ஆகும்.  

அ) ரரயான்    ஆ) டநலான்     இ) அக்ரிலிக்      ஈ) பாலியஸ்டர ்

 

3. ஓர் இயற்டக இடையிடனச ்சுைரில் காை்டினால் அே்விடை __________  

அ) உருகும்   ஆ) எரிதல்    இ) ஒன்றும் ஏற்படுவதில்நல  ஈ) வவடித்தல்  

 

4. கம்பளிடயப் வபான்ற பண்புகடளக் தகாண்ை தசயற்டக இடை __________ ஆகும்.  

அ) நைலான்    ஆ) பாலிவயஸ்டர ்   இ) அக்ரிலிக்   ஈ) PVC 

 

5. தநகிழியின் சிறந்த பயன்பாதைன்பது __________ என்ற பயன்பாை்டில் அறியலாம்.  

அ) இரத்தப்டபகள்       ஆ) வைகிழிக் கருவிகள்     

இ) வைகிழி உறிஞ்சுக் குழாய்கள்   ஈ) வைகிழி ரகரி நபகள் 

 

6. __________ என்பது மை்கும் தன்டமயற்ற ஒரு தபாருள்  

அ) காகிதம்   ஆ) தநகிழி புை்டி     இ) பருத்தி துணி   ஈ) கம்பளி 

 

7. PET என்பது __________ இன் சுருக்தகழுத்தாகும்.  

அ) பாலிவயஸ்டர ்         ஆ) பாலிவயஸ்டர ்மற்றும் வடரிலின்  

இ) பாலிஎத்திலின்தைரிப்தாவலை்       ஈ) பாலித்தின்வடரிலின் 

II. வகாடிை்ை இைங்கடள நிரப்புக. 

1. ______என்பது பாலிவயஸ்டர ்துணிக்கு ஓர ்எடுத்துக்காட்டு ஆகும்.  (PET ) 

2. பல்வநக வைகிழிகநள இனம்காண ______பயன்படுகின்றன. (தரசின் குறியீடு) 

3. சிறிய அலகுகளான பல ஒற்நறப்படிகளின் வதாடரச்ச்ியான சங்கிலித் வதாடர ்அநமப்பின் 

வபயர ்_______ஆகும். ( பலபடி) 

4. முழுநமயான இயற்நக இநழயின் எடுத்துக்காட்டு ______ஆகும். (பருத்தி) 

5. கக்கூன்கநளக் வகாதிக்க நவத்துப் வபறும் இயற்நக இநழ ______என்று வபயர.்(பை்டு) 

III. சரியா தேறா 

1. அதிக அளவிலான வைகிழிகள் சுற்றுசச்ூழநல பாதிக்கின்றன    சரி 

2. மறுத்தல் (தவிரத்்தல்) என்பது வைகிழிநயக் நகயாளும் சிறை்த முநறயாகும்.  சரி 

3. வசயற்நக இநழகளான ஆநடகநள அணிை்து சநமயலநறயில் ரவநல வசய்வது 

சிறை்தரத.   தேறு 

இயற்நக இநழகளான ஆநடகநள அணிை்து சநமயலநறயில் ரவநல வசய்வது சிறை்தது.  

4. வீரியம் குநறை்த வைகிழிகள் சிநதை்து நமக்ரராவைகிழிகள் என்ற சிறிய துகள்களாகும்   சரி 

5. பருத்தி என்பது ஓர ்இயற்நகயான பாலிமர ்ஆகும்   சரி 
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IV. தபாருத்துக. 

1. நைலான்  -  வவப்பத்தால் இளகும் வைகிழி  

2. PVC – .   வவப்பத்தால் இறுகும் வைகிழி 

3. ரபாக்நலட்      இநழ 

4. வடப்லான் –   மரக்கூழ்  

5. ரரயான் –   ஒட்டாத சநமயல்கலன்கள்  

விடைகள் : 

1. நைலான்  -   இடை  

2. PVC –    தேப்பத்தால் இளகும் தநகிழி  

3. ரபாக்நலட் –   தேப்பத்தால் இறுகும் தநகிழி 

4. வடப்லான் –  ஒை்ைாத சடமயல்கலன்கள்  

5. ரரயான் –   மரக்கூை் 

 

V. சரியான ேரிடசயில் எழுதுக  

1. ைீர,்மாவு,வினிகர ்மற்றும் கிளிசரிநனக் வகாண்ட ஒரு சநமக்கும் கலநனக் கலக்கவும்.  

2. இப்வபாருநள ைாம் பயன்படுத்தும் முன் 24 மணி ரைரம் குளிரநவக்கவும்.  

3. ஒரு குவநன ரபான்ரறா ஒரு கிண்ணம் ரபான்ரறா வடிவமாக்கவும். 

4. அை்தத் திரவம் வதளிவநடயும் வநர மிதமான சூட்டில் வதாடரை்்து கலக்கவும்.  

5. அை்தத் திரவமானது வகாதிக்கத் வதாடங்கும் வபாழுது அதநன அடுப்பில் இருை்து 

எடுத்துவிடலாம்.  

6. அை்த வெல்லிநன அலுமனியத் தட்டின் ரமல் பரப்பி விடவும். 

விடைகள் :  

1. ைீர,் மாவு,வினிகர ்மற்றும் கிளிசரிநனக் வகாண்ட ஒரு சநமக்கும் கலநனக் கலக்கவும். 

2. அை்தத் திரவம் வதளிவநடயும் வநர மிதமான சூட்டில் வதாடரை்்து கலக்கவும்.  

3. அை்தத் திரவமானது வகாதிக்கத் வதாடங்கும் வபாழுது அதநன அடுப்பில் இருை்து எடுத்து 

விடலாம். 

4. அை்த வெல்லிநன அலுமினியத் தட்டின் ரமல் பரப்பி விடவும்.  

5. ஒரு குவநள ரபான்ரறா ஒரு கிண்ணம் ரபான்ரறா வடிவமாக்கவும்.  

6. இப்வபாருநள ைாம் பயன்படுத்தும் முன் 24 மணிரைரம் குளிர நவக்கவும். 

 

VI. ஒப்புடம தருக.   

1. பருத்தி : இயற்டக :    பாலிதயஸ்ைர் : _____  (தசயற்டக ) 

2. PLA கரண்டி : மை்கும் தன்டம :: தநகிழி ஸ்பூன் : ______ (மை்காத் தன்டம ) 

3. டநலான் : தேப்பத்தால் உருகும் : பை்டு : ______ (எரியும்) 

 

VII. ோக்கியம் மற்றும் காரணம்  

1. வாக்கியம் : மண்ணில் புநதக்கப்பட்ட காய்கறித் ரதால்கள் இரு வாரங்களில் மநறை்து 

ரபாகின்றன.  

காரணம் : காய்கறித் ரதால்கள் மட்கும் தன்நம வகாண்டநவ  
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 ANS : வாக்கியம் (A) மற்றும் காரணம் (R) சரி, (R) ஆனது (A) யின் சரியான விளக்கம்.  

2. வாக்கியம் : நைலான் ஆநடகள் சிநதை்து நமக்ரரா இநழகளாக மாற அதிக காலமாகும். 

ஆனால் பருத்தி ஆநடகள் சிநதவநடய ஆறு மாதகாலம் ரபாதுமானது.  

காரணம் : நைலான் வபட்ரராலிய ரவதிப்வபாருள்களால் தயாரிக்கப்படுவதால் மட்கும் 

தன்நம வபற்றிருப்பதில்நல. பருத்தித் துணி மட்கும் தன்நம வகாண்டது.  

ANS : வாக்கியம் (A) மற்றும் காரணம் (R) சரி. (R) ஆனது (A) யின் சரியான விளக்கம்.  

3. வாக்கியம் : வைகிழி வபாருள்கநளத் தவிரப்்பது ைல்லது.  

காரணம் : வைகிழிகள் சுற்றுச ்சூழநல மாசுபடுத்துகின்றன.  

ANS : வாக்கியம் (A) மற்றும் காரணம் (R) சரி, (R) ஆனது (A) யின் சரியான விளக்கம். 

VIII. குறுக்தகழுத்து  
 

இைமிருந்து ேலம்  

1. வசயற்நக கம்பளியாகப் பயன்படும் இநழ  

2. ைீர ்பாட்டில்கள் உருவாக்கத் ரதநவப்படும் வைகிழி  

கீழிருந்து வமல்  

3. குநற - வசயற்நக இநழயான இதற்கு வசயற்நகப்பட்டு என்ற வபயரும் உண்டு  

4. சிறிய ஒற்நறப்படிகளின் வதாடரச்ச்ியான ரசரக்்நக உருவாக்கும் ைீண்ட சங்கிலிப் வபாருள்  

வமலிருந்து கீை்  

5. கூட்டிலிருை்து வபறப்படும் ஒரு வநகயான இயற்நக இநழ. 

6. பாலிவயஸ்டர ்என வநகப்படுத்தப்படும் ஓர ்வசயற்நக இநழ  

7. கயிறு தயாரிப்பில் பயன்படும் பலபடி  

 

விடைகள் :  

1. அக்ரிலிக்    2. பாலி எத்திலின் வடரிப்தாரலட் (PET)    3. பாலிமர ்  4. ரரயான்  5. பட்டு 

6. அக்ரிலிக்    7. நைலான் 
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IX. மிகக் குறுகிய விடை தருக.  

1. பருத்திநய உருவாக்கும் பலபடிகளின் இரசாயனப் வபயர ்என்ன?     வசல்லுரலாஸ்  

2. வைகிழிவபாருள்கள் வவவ்ரவறு பண்புகநளயும் குணங்கநளயும் எங்ஙனம் வபறுகின்றன 

➢ குநறை்த எநட  

➢ அதிக வலிநம  

➢ சிக்கலான பல வடிவங்கநள எடுக்கும் தன்நம  

➢ இளகும் தன்நம  

➢ ைீரிநன உட்புகவிடாத தன்நம 

➢ புற ஊதாக் கதிரக்நள உட்புக விடாத தன்நம  
 

3. வைகிழிகநளயும், வசயற்நக இநழகநளயும் எரிப்பது ைல்லதல்ல, ஏன்?  

        இநவகநள எரிப்பதால் ைசச்ுத்தன்நமயுள்ள வாயுக்கள் ரவதிப் வபாருட்கள் உருவாகி 

புற்றுரைாய் ரபான்ற தீங்கு விநளவிக்கும் ரைாய்கநள உருவாக்கும்.  

4. வைகிழியினால் வசய்த வாளியானது துருப்பிடிப்பதில்நல. ஆனால் இரும்பு வாளி 

துருப்பிடித்து விடுகிறது ஏன்?  

➢ இரும்பு வாளி காற்றுடன் விநனபுரிை்து  துருப்பிடிக்கிறது.  

➢ வைகிழி வாளி காற்றுடன் விநனபுரிவதில்நல,எனரவ அது துருப்பிடிப்பதில்நல.  

5. வைகிழிப் வபாருள்கநளத் தவிரப்்பது எவ்வாறு சிறை்த முநறயாகும்?  

✓ வைகிழிகள் ைமது சுற்றுப்புறம், விலங்குகள் , ைமது ஆரராக்கியம் தீய 

விநளவுகநள உண்டாக்குகிறது. 

✓ வைகிழி, மண்ணில் மட்கி  சிநதவநடவது இல்நல.  

✓ மட்கி மநறயாமல் இருப்பதால், எல்லா இடங்களிலும் ைிநறை்து  சுற்றுசச்ூழல் 

பாதிப்நப ஏற்படுத்துகின்றன.  

✓ விலங்குகள் உணவுடன் ரசரத்்து வைகிழிப் நபகநளயும்  உண்பதால் அநவ 

இறக்கின்றன .  

www.Padasalai.Net                                                  www.TrbTnpsc.com
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✓ கடல் ைீரில் குவியும் வைகிழிகள் சிறிய நமக்ரரா வைகிழிகளாக மாறுவதால் 

கடல் உயிரிகள் அழிகின்றன.  

✓ எனரவ வைகிழிப் வபாருள்கநளத் தவிரப்்பது சிறை்த முநறயாகும். 

6. வவப்பத்தால் இறுகும் வைகிழிப் வபாருள்களுக்கு இரு எடுத்துக்காட்டுகள் தருக. 

• ரபக்கநலட் , • வமலமின்  

7. 5R தகாள்டக என்பது என்ன?  
 

• Refuse (தவிர)்  

• Reduce (குநற) 

• Reuse (மீண்டும் பயன்படுத்து)  

• Recycle (மறுசுழற்சி வசய்) 

• Recover (மீட்வடடு) 

X. சிறுவினா  

1. ''மட்கும் தன்நம வாய்ை்தநவ' என்ற வசால்லின் வபாருள் என்ன? 

இயற்நகயாலும், பாக்டீரியாவாலும் சிநதவநடயும் வபாருள்கள் மட்கும் தன்நம 

வாய்ை்தநவ எனப்படும்.  

2. ரகாநடக் காலங்களில் விநளயாடும் வபாழுது அணிய ஏதுவான ஆநடவநக எது? ஏன்?  

➢ இயற்நக இநழகளாலான ஆநடவநககநள அணிய ரவண்டும்.  

➢ ஏவனனில் இயற்நக இநழகள் அதிக அளவு ைீநர உறிஞ்சுகின்றன.  

➢ அதிக அளவு காற்ரறாட்டம் உள்ளதால் உடநல குளிரச்ச்ியாக்க உதவுகின்றன.  

3. விலங்குகள் மற்றும் சுற்றுசச்ூழலில் வைகிழியின் தாக்கம் என்ன? வ  

✓ வைகிழிப் நபகளில் உள்ள உணவுகநள உண்ணும்ரபாது விலங்குகள் வைகிழி    

நபகநளயும் உண்பதால் அநவ இறக்கின்றன .  .  

✓ பாலித்தீன் நபகள் சுற்றுப்புறத்நத மாசுபடுத்தி வடிகால்கநள அநடத்து 

மாசுபடுத்துகின்றன.  

✓ வடிகால்களில் அநடப்பு ஏற்படுவதால் ைீர ்ரதங்கி ைிற்கின்றது.  

✓ ரதங்கிய ைீரினால்  வகாசுக்கள் வபருகி மரலரியா, வடங்கு, சிக்கன்குனியா ரபான்ற 

ரைாய் கள் பரவுகின்றன.  

✓ வபரு வவள்ளம் ஏற்படவும் காரணமாகிறது. 

 

XI. தநடுவினா  
 

1. வசயற்நக இநழகளின் பயன்கநளயும், வரம்புகநளயும் பட்டியலிடுக. 

 

➢ ைிறம் மங்குவது இல்நல. 

➢ சுருங்குவது இல்நல.  

➢ பல  வருடங்களுக்கு அரத வபாலிவுடன் காட்சியளிக்கின்றன.  

➢ அதிக வலிநம உநடயது. 
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➢ அதிக ைீட்சித்தன்நம வகாண்டது.  

தசயற்டக இடைகளின் குடறபாடுகள் :  

✓ வவப்பத்நதத் தாங்கும் திறனற்றநவ.  

✓ எளிதில் தீப்பற்றக் கூடியநவ.  

✓ குநறை்த அளரவ ைீநர உறிஞ்சுகின்றன.  

✓ ரதநவயான காற்ரறாட்டத்நதத் தருவதில்நல. எனரவ அணியும்ரபாது வவப்பம் 

அதிகமாகிறது. .  

✓ நுண்ணிய துகள்களாய் உதிரை்்து ைீரை்ிநலகள், ைிலத்நத மாசுபடுத்துகின்றன. 

 

2. வைகிழிப் வபாருள்கநள அகற்றும் பாதுகாப்பான முநறகள் சிலவற்றிநன 

பரிை்துநரக்கவும். 

✓ வைகிழிகநள மட்கும் தன்நம, மட்கா தன்நமயற்றநவ என பிரித்து  

அப்புறப்படுத்துவது ைல்லது..  

✓ வைகிழிக் குப்நபகநள அகற்ற 5R - வகாள்நகநய முயற்சிக்க ரவண்டும்.  

• Refuse (தவிரத்்தல்)  

கநடகளுக்குச ்பருத்தி அல்லது சணல் நபகநள வகாண்டு வசல்லரவண்டும்..  

• Reduce (குநறத்தல்)  

✓ வைகிழிப் வபாருநள வாங்குமுன் அதற்கு பதிலிப் வபாருள் உள்ளதா என 

பாரத்்தபின் வாங்கலாம்.  

• Reuse (மீண்டும் பயன்படுத்துதல்) 

✓ வைகிழி வபாருள்கநள தூக்கிவயறியாமல்  மீண்டும் மீண்டும் பயன்படுத்தலாம்.  

• Recycle (மறுசுழற்சி வசய்தல்)  

✓ வரசின் குறியீடுகளின் அடிப்பநடயில் வைகிழிக் கழிவுகநள பிரித்வதடுத்து 

மறுசுழற்சி வசய்யலாம்.  

• Recover (மீட்வடடுத்தல், மட்குதல் மற்றும் எரித்துச ்சாம்பலாக்குதல்) 

✓ வைகிழிப் வபாருள்கநள உயர ்வவப்பைிநலயில் எரித்து வவளியாகும் வாயுக்கநளக் 

ரசகரித்தும்,ைசச்ுத்தன்நம வாய்ை்த சாம்பநல கவனமாகப் பிரித்தும் மின்சாரம் 

தயாரிக்கலாம்.  

✓ இநவகரள  வைகிழிக் கழிவுகநளக் நகயாள்வதற்கு சாதகமான வழியாகக் 

கருதப்படுகிறது. 

 

XII. உயர் சிந்தடனத் திறன் வினாக்கள்  

1. ஒருமுநற மட்டுரம பயன்படுத்தித் தூக்கிவயறிப்படும் வைகிழிகநளத் தமிழ்ைாடு அரசு தநட 

வசய்துள்ளது. அரசின் இை்தச ்வசயல்பாடு எவ்வநகயில் முக்கியத்துவம் வபறுகிறது.  
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✓ இதனால் சுற்றுசச்ூழல், விலங்குகள், ைமது ஆரராக்கியத்தின் மீது வைகிழிகளால் 

ஏற்படும் பாதிப்புகள் குநறயும்.  

✓ வைகிழிகுப்நபகள் ரசரை்்து சுற்றுச ்சூழல் பாதிக்கப்படுவதும், ைீரை்ிநலகளில் 

அநடப்பு ஏற்படுவதும் குநறகிறது.  

✓ இதனால் வகாசுக்களால் ஏற்படும் மரலரியா, வடங்கு, சிக்குன்குனியா ரபான்ற 

ரைாய்கள் கட்டுப்படுத்தப்படுகின்றன.  

 

2. வைகிழிப் நபகள் சிநதவநடய ஏறத்தாழ 500 ஆண்டுகள் ஆகும் என ைாம் அறிரவாம். 

ஒரு தநலமுநற மாற 30 ஆண்டுகள் ஆகும். எனில், அை்த வைகிழிப்நப மட்குவதற்கு 

எத்தநன தநலமுநறகள் ரதநவப்படும்.?  

 

   வைகிழிப்நப மட்குவதற்கு 16 தநலமுநறகள் ரதநவப்படும். 

XIII. பதில் எழுதுக.  
 

• ைாம் பயன்படுத்தும் வபாருள்கள் எது?  

வைகிழி பாட்டில்கள், தட்டுகள், டம்ளரக்ள், வகாள்கலன்கள், உடுத்தும் ஆநடகள் 

 • இன்று காநல உங்கள் நககளில் பட்ட முதல் வைகிழிப் வபாருள் என்ன?  

பல் துலக்கும் பிரஷ் 

• உங்கள் வகுப்பநறநய பாரந்வயிட்டு அதில் காணப்படும் வைகிழியால் ஆன 

வபாருள்கநளப் பட்டியலிடுக.  

ைாற்காலி, ரபனா, வபன்சில் டப்பா, ஸ்ரகல்  

• உங்கள் மதிய உணநவ எடுத்துச ்வசல்வதற்கும், தண்ணீநர எடுத்துச ்வசல்வதற்கும் ைீங்கள் 

பயன்படுத்தும் வபாருள்களின் வநககள் யாநவ?  

✓ மதிய உணவுக்கலன் - பாலி காரப்ரனட் (PC)  

✓ தண்ணீநர எடுத்துசவ்சல்லும் பாட்டில் - பாலி காரப்ரனட் (PC), PET.  

• உங்களிடம் உள்ள துணிகளின் வநககநளப் பட்டியலிடுக.  

நைலான், பாலிவயஸ்டர,் பருத்தி, பட்டு 

 

XIV. வகாடிை்ை இைங்கடள நிரப்புக. 
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ii) வகாடுக்கப்பட்டுள்ள படத்திநன உற்றுரைாக்கி என்ன ைடக்கிறது என்பநத விளக்குங்கள்.  

 
 

✓ தூக்கி எறியும் வைகிழி பாட்டில்கள், ரகன்கள் வடிகாநல அநடத்து வகாள்கிறது  

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID: padasalai.net@gmail.com

w
w

w
.P

ad
as

al
ai

.N
et

w
w

w
.P

ad
as

al
ai

.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://whatsapp.com/channel/0029VaAqUqk9Bb672tBn033m


✓ ரதங்கிய கழிவு ைீரால் வகாசுக்கள் வபருகி மரலரியா, வடங்கு மற்றும் சிக்குன்குனியா 

ரைாய்கள் பரவுகின்றன.  

✓ கழிவு ைீர ்ரதங்குவதால் மநழக்காலங்களில் வவள்ள ைீர ்வடியாது.  

 

iii) வகாடுக்கப்பட்டுள்ள தகவல்கநளப் படித்து, அவற்நற வநரபடத்தில் குறிக்கவும், 

ைாடுகநளயும் அநவ பயன்படுத்தும் வைகிழிப் வபாருள்களின் அளநவயும் ஒப்பிடுக 

 

. 

 
 

Prepared by Subbiah Palaniyandi 
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4.அன்றாட வாழ்வில் வவதியியல் 
 

I. சரியான விடடடயத் வதர்ந்ததடுத்து எழுதுக.  

1. நிம ோனியோ,  ற்று ் மூசச்ுக்குழோய் அழற்சி சிகிசச்சயில் பயனுள்ள ஒரு  ருந்து ______ 

அ) ஸ்ட்ரெப்மடோச சின் ஆ) குமளோமெோ ்ரபனிகோல்  இ) தென்சிலின்  ஈ) சல்போகுனிடின்  

2. ஆஸ்பிெின் ஒரு _______  

அ) ஆண்டிபயோடிக்    ஆ) ஆண்டிடெரடிக்    இ)  யக்க  ருந்து      ஈ) சசக்கீரடலிக் 

3. _______ என்பது வயிற்று அமிலத்சத நடுநிசலயோக்குகிறது.  

அ) அமிலநீக்கி.   ஆ) ஆண்டிசபெடிக்     இ) வலிநிவோெணி      ஈ) ஆண்டிஹிஸ்டமின் 

4. ஒரு ரபோருள் தீப்பிடிக்க மதசவயோன மிகக் குசறந்த ரவப்பநிசல அதன் ____ என 

அசழக்கப்படுகிறது.  

அ) ரகோதிநிசல   ஆ) உருகுநிசல    இ) சிக்கலோன ரவப்பநிசல   ஈ) எரிதவெ்ெநிடல 

5. ர ழுகுவத்தியின் சுடெில் ரவப்ப ோன பகுதி எது ________ 

அ) நீலம்     ஆ)  ஞ்சள்      இ) கருப்பு       ஈ) உள் பகுதி 

II. வகாடிட்ட இடங்கடை நிரெ்ெவும் 

1. ரபன்சிலின் முதன்முதலில் கண்டுபிடித்தவெ ்_____  (Dr.அதலக்சாண்டர் பிதைமிங்) 

2. உலக ORS தின ் __________ (ஜூடல 29) 

3. எெிதல் என்பது ஒருமவதிவிசன,இதில்ரபோருள் _____ உடன் விசனபுெிகிறது. (ஆக்சிஜன்) 

4. நீெில் நசனந்த கோகிதத்தின் எெிரவப்பநிசல ________ (அதிகம்) 

5. எண்சனயோல் உற்பத்தி ரசய்யப்படு ் ரநருப்சப_____ ஆல் கட்டுப்படுத்த முடியோது (நீர்) 

III. சரியா அல்லது தவறா? தவறு என்றால் சரியான ெதிடலக் தகாடுக்கவும்  

1. சளி  ற்று ் புளூ மபோன்ற மநோய்கசள ஏற்படுத்து ் சவெஸ்களுக்கு ஆண்டிபயோடிக்குகள் 

 ருந்துகள் மவசல ரசய்யு ்  தவறு 

சளி  ற்று ் புளூ மபோன்ற மநோய்கசள ஏற்படுத்து ் சவெஸ்களுக்கு ஆண்டிபயோடிக்குகள் 

மவசல தசய்யாது  

2. வலி நிவோெணி என்பது கோய்சச்லின் மபோது ரவப்பநிசலசயக் குசறக்கு ் 

ரபோருட்கள்  தவறு 

ஆண்டிடெரடிக்குகை் (உடல் தவ ெ்ெம் தனிெ்பி) என்பது கோய்சச்லின் மபோது 

ரவப்பநிசலசயக் குசறக்கு ் ரபோருட்கள் 

3. அசனத்து எெிரபோருள்களு ் சுடசெ உருவோக்குகின்றன தவறு 

அசனத்து எெிரபோருள்களு ் சுடசெ உருவாக்குவதில்டல  

4. எெிதலுக்கு ஆக்ஸிஜன் அவசிய ்  சரி 

5.  ெ ்  ற்று ் நிலக்கெிசய எெிப்பதோல் கோற்று ோசுபடுகிறது. சரி 

IV. தொருத்துக. 
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1. ஆண்டிசபெடிக் –  வலிசயக் குசறக்கு ் 

2. வலி நிவோெணி –.   உடல் ரவப்பநிசலசயக் குசறக்கு ் 

3. ஆன்டோசிட் – .   தன்னிசச்சயோன எெிப்பு  

4. போஸ்பெஸ் –    சுவோச பிெசச்சனக்கு வழி வகுக்கிறது  

5. கோெப்ன் சட ஆக்சசடு –  அலுமினிய ் சைட்ெக்சசடு 

விடடகை் : 

  1. ஆண்டிசபெடிக் –   உடல் தவெ்ெநிடலடயக் குடறக்கும்  

  2. வலி நிவோெணி –    வலிடயக் குடறக்கும் 

  3. ஆன்டோசிட் –    அலுமினியம் டைட்ரக்டசடு  

  4. போஸ்பெஸ் –    தன்னிசட்சயான எரிெ்பு  

  5. கோெப்ன் சட ஆக்சசடு –  சுவாச பிரசச்டனக்கு வழி வகுக்கிறது 

 V. ஒெ்புடம 

1. சுடெின் உள் ண்டல ் : _____   சுடெின் ரவளி ண்டல ் ______ 

(குடறந்த தவெ்ெம், அதிகதவெ்ெம்) 

2. டிஞ்செ ்: ______  ஹிஸ்டச ன் : _______ 

(அன்டிதசெ்டிக்,  ஒவ்வாடம ொதிெ்பு நீக்க மருந்து ) 

 

VI. ஓரிரு தசாற்கைில் விடடயைி  
 

1.  னிதனில் கண்டறியப்பட்ட முதல் சவெஸ் மநோய் _______ ( ஞ்சள்கோய்சச்ல் / 

ரடங்குகோய்சச்ல்)      மஞ்சை் காய்சச்ல் 

2. ORS - ன் விெிவோக்க ் _____ (Oral Re-hydration Solution (வாய்வழி நீவரற்று கடரசல்) 

3. கிருமி நோசினியோகவு ் ஆண்டிரசப்டிக் ஆகவு ் பயன்படக்கூடிய ஒரு  ருந்தின் ரபயசெக் 

குறிப்பிடுக?  :ஃபீனால் 

4. ரடட்டோலின் முக்கிய கூறுகள் யோசவ? 

குவைாவராடசலினால் மற்றும் ஆல்ொ தடர்பீனியால்  

5. எெிரபோருளின் கமலோெிஃபிக்  திப்பின் அலகு என்ன? 

கிவலா ஜூல் / கிவலாகிராம்  

6. எத்தசன வசகயோன எெிதல் உள்ளது? 

மூன்று வசகயோன எெிதல்  

i) மவக ோக எெிதல்  ii) தன்னிசச்சயோன எெிதல்   iii) ர துவோக எெிதல் 

7. ரநருப்சப உற்பத்தி ரசய்வதற்கோன அத்தியோவசிய மதசவகள் யோசவ? 

i) எெிரபோருள்   ii) கோற்று (ஆக்சிஜசன வழங்க  iii) ரவப்ப ் (ரவப்பநிசலசய உயெத்்த)  

iv) எெிதல் ரவப்பநிசல 

VII. குறுகிய விடடயைி  
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1.  ருத்துவெக்சளக் கலந்தோமலோசிக்கோ ல் ஏன்  ருந்துகள் எடுக்கக்கூடோது? 

• குறிப்பிட்ட மநோய்க்கோன  ருந்து எது என ந க்குத் ரதெியோது.  

• எடுக்க மவண்டிய  ருந்தின் அளவு ந க்குத் ரதெியோது.  

• குறிப்பிட்ட  ருந்து ந க்கு தீங்கு விசளவிக்கு ோ என்பது ரதெியோது. 

 

2. கிருமிநோசினிகள் ஆண்டிரசப்டிக்லிருந்து எவ்வோறு மவறுபடுகின்றன? எடுத்துக்கோட்டுடன் 

விளக்கவு ்.  

ஆண்டிதசெ்டிக் 

1. மநெடியோக உயிருள்ள ரசல்களின் மீது பயன்படுத்தப்படுகிறது  (எ.கோ) மதோல் / சளி  

2. அசனத்து ஆன்டிரசப்டிக்களு ் கிருமி நோசினிகள் ஆகு ். (எ.கோ) ரடட்டோல்  

கிருமிநாசினிகை் 

1. உயிெற்ற ரபோருள் மீது ரதளிக்கலோ ் (எ.கோ) ம ற்பெப்பு, ஆய்வக ம சச, தசெகள்  

2. அசனத்து கிருமி நோசினிகளு ் ஆன்டிரசப்டிக் அல்ல (எ.கோ) ஆல்கைோல் 

3. எெிதல் ரவப்பநிசல என்றோல் என்ன? 

ஒரு ரபோருள் எெிவதற்குத் மதசவயோன குசறந்தபட்ச ரவப்பநிசல அதன் எெிதல் 

ரவப்பநிசல ஆகு ். 

4. 4.5 கிமலோ எெிரபோருள் முழுவது ோக எெிந்து உற்பத்தி ரசய்யப்படு ் ரவப்பத்தின் அளவு 

180000 kg என அளவிடப்படுகிறது என்றோல், கமலோெிஃபிக்  திப்பு என்ன?                        

கமலோெிஃபிக்  திப்பு  = உற்பத்தி ரசய்யப்படு ் ரவப்ப ் / எெிக்கப்படு ் எெிரபோருளின் 

அளவு   = 1,80,000 / 4.5        = 40,000 KJ / Kg 

VIII. விரிவாக விடடயைி  

1. ஆண்டிபயோடிக்  ற்று ் வலிநிவோெணி பற்றிச ்சுருக்க ோக விளக்குங்கள்?  

ஆண்டிெயாடிக்குகை் :  

• சில தோவெங்களு ், நுண்ணியிெிகளு ்  ற்ற உயிெினங்கசள அழிக்க உதவு ் 

நசச்ுதன்ச யுள்ள ரபோருள்கசள உற்பத்தி ரசய்கின்றன. அசவ ஆன்டிபயோடிக்குக் 

எனப்படுகின்றன.  

(எ.கோ) ரபனிசிலின், குமளோெ ்பினிகோல், ரடட்ெோசசக்களின்  

வலி நிவாரணிகை் :  

➢ வலி நிவோெணிகள் என்பன ந து உடலிலிருந்து ரவளியோகு ் வலி - குசறக்கு ் மவதி 

ரபோருளோகு ்.  

➢ அசவ ரவளிமயறி வலி என்ற உணெச்வக் கட்டுப்படுத்துகிறது. 
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➢ ச ய நெ ்பு  ண்டலத்தில் மநெடியோக ரசயல்பட்மடோ அல்லது வலி உணெப்படு ் 

புறநெ ் இடங்களில் அதிக  ோற்ற ் இல்லோத நிசலயில் குறிப்போக இவ்வசக வலி 

நீக்கிகமள ரசயல்படுகிறது.  

• அசவ இரு வசகப்படு ் :  

1) மபோசதத்தன்ச யற்ற வலி நீக்கிகள். (எ.கோ) ஆஸ்பிெின் 

2) மபோசதத்தன்ச  வோய்ந்த வலிநீக்கிகள். (எ.கோ) மகோடீன்  

 

2. ர ழுகுவத்தி சுடெின் பட ் வசெந்து போகங்கசளக் குறிக்க. 

 

 

IX. ெடம் சார்ந்த வகை்வி 

1. அருளு ், ஆகோஷு ் ஒரு பெிமசோதசனசயச ் ரசய்து ரகோண்டிருந்தனெ.் அதில் ஒரு 

பீக்கெில் தண்ணீசெ சூடோக்க மவண்டு ். அருள் பீக்கசெ ர ழுகுவத்திச ் சுடெின் 

 ஞ்சள் பகுதியில் திெியின் அருமக சவத்திருந்தோெ.் ஆகோஷ் பீக்கசெ ரவளிப்புறத்தில் 

உள்ள சுடெில் சவத்திருந்தோெ.் குறுகிய மநெத்தில் யோருசடய நீெ ்சூடோகு ்?  

2.  

 

• குறுகிய மநெத்தில் ஆகோஷ் சவத்த நீெ ்சூடோகு ்  

• ஏரனனில் ரவளிப்புற நீல நிறசச்ுடெ ்அதிக ரவப்ப ோன பகுதி  

• எனமவ ரவளிப்புறச ்சுடெில் சவக்கப்பட்ட நீெ ்குறுகிய மநெத்தில் சூடோகு ். 

 

Prepared by Subbiah Palaniyandi 

www.Padasalai.Net                                                  www.TrbTnpsc.com

Kindly Send Me Your Study Materials To Us Email ID: padasalai.net@gmail.com
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5.அன்றாட வாழ்வில் விலங்குகள் 
 

I.சரியான விடடடயத் ததர்வுசசய். 

1. __________ தினசரி, கால்நடைகளிலிருந்து நமக்குக் கிடைக்கும் முக்கியமான ப ாருளாகும்.  

அ) முை்டை   ஆ) பால்    இ) இடை இரண்டும்   ஈ) இடை எதுவும் அல்ல 

2. முை்டையில் __________ அதிகம் உள்ளது.  

அ) புரதம்  ஆ) காரப் ா டைை்பரை்   இ) பகாழு ்பு   ஈ) அமிலம் 

3. பைள்ளாடு மற்றும் பசம்மறி ஆடுகளின் எந்த  ாகம் __________ ஆடைகள் தயாரிக்க 

உதவுகிறது?  

அ) கால்     ஆ) டக     இ) உதராமம்   ஈ) தடல   

4.  ை்டு ் பூசச்ிகடள ைளர ்் தும்,  ை்டு இடைகடள உருைாக்குைதும் இை்ைாறு 

அடைக்க ் டுகிறது __________  

அ) ைாரை்்டிகல்சர ்   ஆ) ஃபுபளாரிகல்சர ்     இ) அக்ரிகல்சர ்    ஈ) பசரிகல்சர ்

5. பிரித்பதடு ் ைரின் பநாய் என்றடைக்க ் டுைது __________ 

அ) ஆஸ்துமா  ஆ) ஆந்தராக்ஸ்     இ) டைஃ ாய்டு    ஈ) காலரா 

 

II. தகாடிட்ட இடங்கடள நிரப்புக. 

1. புரதம் மற்றும் _______பாலில் அதிகம் உள்ளது.  (கால்சியம்) 

2. ததன் கூட்டிலிருந்து _______எடுக்கப்படுகிற  (ததன்) 

3. ஆந்தராக்ஸ் தநாடய உண்டாக்குவது ______(தபசில்லஸ் ஆந்த்ராசிஸ்) 

4. இயற்டக இடழகளிதலதய வலிடமயான இடழ ______ (பட்டு) 

5. அடமதிபட்டு __________ ஆம் ஆண்டு உருவாக்கப்பட்டது. (1992) 

 
 

III. சரியா, தவறா? தவசறனில் சரியானடத எழுதவும்  

1. இயற்டகயின் மிக ் ப ரிய பகாடை விலங்குகள். சரி 

2. குதிடரயின் உபராமம் ஓவியம் தீை்டும் தூரிடககளில்  யன் டுத்த ் டுகிறது. சரி 

3.  ை்டு ்பூசச்ி கம் ளி இடைகடளத் தருகிறது.  தவறு  

ஆடு கம் ளி இடைகடளத் தருகிறது.  

4. அஹிம்டச ்  ை்டின் மறுப யர ்மல்ப ரி  ை்டு  தவறு  

அஹிம்டச ்  ை்டின் மறுப யர ்அடமதிப்பட்டு.  

5. ஆந்த்ராக்டஸக் குண ் டுத்தும் சிறந்த மருந்து ப னிசிலின்  சரி 
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IV. சபாருத்துக. 

1. கூை்டுபுழு –    இடறசச்ி  

2. அடமதி ை்டு –    பகாழி ் ண்டண 

3. பிராய்லர ்–    ை்டு ் பூசச்ி  

4. இனி ் ான திரைம் –  ஆந்திர ்பிரபதசம் 

5. ஆடு –    பதன் 

விடடகள் : 

1. கூை்டுபுழு –   பட்டுப் பூசச்ி  

2. அடமதி ை்டு –    ஆந்திரப்பிரததசம்  

3. பிராய்லர ்–    தகாழிப்பண்டண 

4. இனி ் ான திரைம் –   ததன் 

5. ஆடு –    இடறசச்ி 

 

V. ஒப்புடம 

1. நீர ்: குைாய் :     : மின்சாரம் : _______  (மின்கம்பி ) 

2. தாமிரம் : கைத்தி :   : கை்டை : ______(மின்கடத்தாப்சபாருள் ) 

3. நீளம் : மீை்ைர ்அளவு :  : மின்சாரம் : _______ (அம்மீட்டர் ) 

4. மில்லி அம்பியர ்: டமக்பரா அம்பியர ்:   : 10-3A : ____ (10-6A) 

VI. மிகக் குறுகிய விடட தருக  

1.  ாலிலிருந்து கிடைக்கும் ப ாருள்களில் எடைபயனும் இரண்டிடன எழுதுக.  

1) தயிர ்  2) பநய்  
 

2. விலங்குகளிைமிருந்து கிடைக்கும் இரு ைடகயான இடைகள் யாடை? 

1) கம் ளி இடைகள்        2)  ை்டு  
 

3. கத்தரித்தல் என்றால் என்ன? 

• ஆடுகளின்  உைலின் சடத ்  குதிகளிலிருந்து உபராமங்கள் கத்தரிக்க ் டுைது  

கத்தரித்தல் என ் டும்.  
 

4. ஆந்தராக்ஸ் பநாயின் அறிகுறிகடள எழுதுக.  

• காய்சச்ல்  , இருமல் ,  மூசச்ுவிடுதலில் சிரமம் ,    

சில சமயம் ைாந்தி மற்றும் ையிற்று ்ப ாக்கு  
 

5. பசரிகல்சர ்- ைடரயறுக்க  

 ை்டு ்பூசச்ிகடள ைளரத்்து, அதிலிருந்து  ை்டு தயாரிக்க ் டுைது,  ை்டு ்பூசச்ி 

ைளர ்்பு அல்லது பசரிகல்சர ்என ் டும்.  
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6. நாம் விலங்குகடள எ ் டி நைத்த பைண்டும்? 

 நாம் விலங்குகளின் மீது அன்பு அக்கடற, பகாண்டு குடும் த்திலுள்ள ஓர ்உறு ்பினர ்

ப ால் ப ணி ைளரக்்க  பைண்டும். 

 

7. அஹிம்டச ்  ை்டைக் கண்ைறிந்தைர ்யார?் 

ஆந்திர ்பிரபதச மாநிலத்தில் அரசு அதிகாரியாக ்  ணியாற்றிய குசுமா ராஜய்யா 

அஹிம்டச ்  ை்டிடன கண்ைறிந்தார.் 

 

VII. குறுகிய விடட தருக.  

1. கம் ளியின் சிற ் ம்சங்கள் மூன்றிடன எழுதுக. 

கம்பளியின் சிறப்பம்சங்கள் :  

i) பை ் ம் மற்றும் தண்ணீருக்கு எதிர ்்புத் தன்டம உடையது  

iii) கம் ளி, குளிருக்கு எதிராகவும்  சிறந்த பை ் க் கைத்தியாகவும் பசயல் டுகின்றது. 

iv) இது எளிதில் சுருங்குைது  மற்றும் கிழிைது இல்டல   

 

2.  ை்டின் ஏபதனும் மூன்று  யன் ாை்டை எழுதுக.  

✓  ை்டு இயற்டக அைகுடையது, பகாடை காலத்தில் இது இதமானதாகவும், குளிர ்

காலத்தில் பை ் த்டதத் தரக் கூடியதாகவும் உள்ளது.  

✓ நாகரிகமான, நவீன உடைகடள அைகாகத் தயாரிக்கவும், முக்கியமாக  ை்டு 

பசடலகள் தயாரிக்க இது  யன் டுகிறது.  

✓  ை்டு இடை மருத்துைத் துடறயில், அறுடை சிகிசட்சயில் டதயல் நூலாக ் 

 யன் டுத்த ் டுகிறது.  

 

3. பகாழி ் ண்டணயில் காண ் டும் ப ாதுைான பநாய்கள் யாடை? 

➢ சால்பமாபனல் பலாசிஸ் (ையிற்று ்ப ாக்கு)  

➢ ரானிக் பகை் பநாய் (அம்டம பநாய்)  

➢ ஆஸ் ரஜ்ில்லஸ் பநாய் ( லவீனம், நலிந்து ப ாதல்) 

 

VIII. விரிவான விடட தருக. 

1. அஹிம்டச  ை்டு  ற்றி விைரிக்க?  

அஹிம்டசப் பட்டு:  

✓ இந்தியாவில் ஆந்திர ்பிரபதச மாநிலத்தில் அரசு அதிகாரியாக ்  ணியாற்றிய குசுமா 

ராஜய்யா என் ைர,் 1992 ஆம் ஆண்டு கூை்டு ்புழுக்கடள அழிக்காமல் அைற்றிலிருந்து 

 ை்டு நூடல எடுக்கலாம் என் டதக் கண்ைறிந்தார.்  

✓ கூை்டு ்புழுக்கள், கூை்டை உடைத்துக்பகாண்டு பைளிபயறும் ப ாது அைற்டறக் 

பகால்லாமல் அடை உண்ைாக்கும்  ை்டு இடைகடள எடுக்கலாம் என்றார.்  

✓ இந்த ்  ை்டு மனித பநயத்தின் அடி ் டையில்  ாரம் ரிய முடறகடளத் தாண்டி 

உருைாக்க ் ை்ைதாகும்.  
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✓ எனபை இது அகிம்டச ் ை்டு அல்லது அடமதி ் ை்டு என்று அடைக்க ் டுகின்றது.  

 

2.  ை்ைாடலகளில் ஏற் டும் அ ாயங்கள் யாடை?  

➢  ை்ைாடலகளில்  ணிபுரி ைரக்ள் நின்று பகாண்பை பைடல பசய்ைதால்  மூை்டு 

ைலியால் அைதி ் டுகிறாரக்ள். 

➢ இைரக்ள் முதுகு ைலி,  ாரட்ைக் பகாளாறுகள் மற்றும் பதால் பநாய்கள் 

உண்ைாகின்றன.   

➢ சுைாச சம் ந்தமான பநாய்களான ஆஸ்துமா மற்றும் மாரப்ுச ் சளியாலும் 

அைதி ் டுகிறாரக்ள்.  

➢ பைதி ்ப ாருள்கள் மற்றும் சலடைத்தூள்கடளயும்  யன் டுத்துைதால் ஒை்ைாடம 

மற்றும் பதால் பநாயால் துன்புறுகிறாரக்ள்.  

➢ கம் ளி ஆடல  ணியாளரக்ள் ஆந்தராக்ஸ்  ாக்டீரியா பதாற்றால் 

அைதி ் டுகிறாரக்ள்.  இது பிரித்பதடு ்ப ாரக்ள் பநாய் என்றும் அடைக்க ் டுகிறது.  

➢ விலங்குகளின் உபராமம் மற்றும் அங்கு ைாழும் விலங்குகடளக் டகயாளுபைாரக்்கும் 

ஆந்தராக்ஸ் பநாய் ஏற் ை ைாய் ்புள்ளது.  

 

IX. பின்வரும் வினாக்களுக்குப் பதில் தருக.  

1. கம் ளி ஆடலயில், கம் ளி தயாரிக்க ் டும் நிடலகடள எழுதுக.  

i) கத்தரித்தல்   ii) தரம் பிரித்தல்  iii) கழுவுதல்   iv) சிக்பகடுத்தல்   v) நூற்றல்  

i) கத்தரித்தல் : 

ஆடுகளின்  உைலின் சடத ்  குதிகளிலிருந்து உபராமங்கள் கத்தரிக்க ் டுைது  கத்தரித்தல் 

என ் டும்.   
 

ii) தரம் பிரித்தல் : 

ஒபர ஆை்டின் பைை்பைறு  ாகங்களிலிருந்தும் எடுக்க ் டும் உபராமங்கள்  தனித்தனியாக ் 

பிரித்பதடுக்க ் டும் இது தரம் பிரித்தல் என ் டும்.  
 

iii) கழுவுதல் : 

பதாலின் உபராமங்களில்  உள்ள தூசி, அழுக்கு மற்றும் எண்பணய் பிசின் ப ான்றைற்டற 

நீக்க சலடைத்தூள் பகாண்டு நன்கு கழுை பைண்டும். 

 

iv) சிக்சகடுத்தல் : 

காய டைத்த கம் ளி இடைகடளக் கைனத்துைன் பிரித்து .ஆடலகளில் உள்ள உருடளகளில் 

பசலுத்தி, பமல்லிய கம்பி ப ான்ற இடையாக மாற்ற பைண்டும். இ ் டிக் கம் ளிடயத் 

தை்டையான தாளாக மாற்றுைது ைடல என ் டும்.  
 

v) நூற்றல் : 

இந்த ைடலடயக் குறுகிய தனித்த நூல் இடையாக மாற்ற, அைற்டற நூற்பு இயந்திரங்களில் 

அனு ்  பைண்டும். இந்த நூல், பின்  ந்துப ால் உருண்டையாக மாறும் இந்த நூல்  ந்து, பின் 

பின்னல்களாக மாற்ற ் ை்டு, ஆடைகள் பநய்ய உதவும். 

 

2. கம் ளியின்  யன்கடள எழுதுக. 

கம்பளியின் பயன்கள்:  

i) கம் ளி என் து,  ல்பைறு ைடகயான ப ாருள்கள் பசய்ய உதவும் இடையாகும்.  
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ii) இந்த இடைகளின் விை்ைம் ஆடைகள், வீை்டிற்குத் பதடையான ப ாருள்கள் பசய்ய 

உதவுகின்றன.  

iii) மூன்றில் இரண்டு  ங்கு கம் ளி இடைகள், ஸ்பைை்ைர,் ஆடைகள், பகாை் மற்றும் 

விடளயாை்டு வீரரக்ள் அணியும் ஆடைகள் தயாரிக்க உதவுகின்றன.  

iv) கம் ளி இடை மற்றும் இயற்டக அல்லது பசயற்டக இடைகபளாடு பசரும்ப ாது அடை 

மடி ்புக்கு எதிர ்்புத் தன்டம உடைய ப ாரட்ைகள் மற்றும் இடரசச்டல உறிஞ்சும் 

விரி ்புகள் தயாரிக்க உதவுகின்றன. 

 

X. உயர் சிந்தடன வினா  

1.  ாராசூை் தயாரிக்க  ை்டு இடைகள் உதவுகின்றன ஏன்?  

➢  ை்டு ஓர ்ைலிடமயான இயற்டக இடையாகும்.  

➢  ை்டு பமல்லிய எடைகுடறந்த மற்றும் எளிதில் தீ ்பிடிக்காத தன்டம பகாண்ைதினால் 

அதிகம்  ாராசூை் தயாரி ்பில் உதவுகின்றன.  

2. பதன் எல்லாருக்கும் சிறந்த உணைாக ்  ரிந்துடரக்க ் டுகிறது ஏன்? காரணம் தருக. 

 

o பதன் மிகுந்த மருத்துை குணம் மற்றும் சத்துக்கள் நிடறந்தது .  

o பநாய்க்கிருமிகளுக்கு எதிராக பசயல் டும்.  

o இரத்தச ்சுத்திகரி ் ானாக பசயல் டுகிறது.  

o இது ஒரு ஆண்டி - ஆக்ஸிைன்ை்களாக பசயல் டுகின்றது . 

o  

XI. கூற்றும், காரணமும்  
 

1. கூற்று : விலங்குகளின் உபராமங்களிலிருந்து இடைகள் எடுக்க ் டுகின்றன. 

காரணம் : ஆடு, யாக், அல் ாகா (உபராம ஆடு) மற்றும் முயல் கம் ளி இடைகடளத் 

தருகின்றன.  

அ) கூற்றும், காரணமும் சரி 

ஆ) கூற்று சரி, காரணம் தைறு  

இ) கூற்று தைறு, காரணம் சரி 

ஈ) கூற்றும், காரணமும் தைறு 

விடட : அ) கூற்றும், காரணமும் சரி  
 

2. கூற்று : ப னிசிலின் மற்றும் சி ்பராஃ ்பளாக்சாசின் 

காரணம் : இந்த மருந்துகள்  சு அம்டமடயக் குணமாக்கும்.  

அ) கூற்று சரி, காரணம் தைறு 

ஆ) கூற்று தைறு, காரணம் சரி  

இ) கூற்றும் தைறு, காரணமும் தைறு 

ஈ) கூற்றும் சரி, காரணமும் சரி 

விடட : அ) கூற்று சரி, காரணம் தவறு  
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6 .காட்சித் ததாடர்பியல் 
 

I. சரியான விடடடயத் ததர்ந்ததடுத்து எழுதுக.  

1. தேரந்்தேடுே்ே உரரரை நகதெடுக்க __________ விரைப்பெரகக் குறுக்குவழி பைன்படுகிறது.  

அ) Ctrl + c    ஆ) Ctrl + v      இ) Ctrl + x             ஈ) Ctrl + A 

2. தேரந்்தேடுே்ே உரரரை தவடட் __________ விரைப்பெரகக் குறுக்குவழி பைன்படுகிறது.  

அ) Ctrl + c     ஆ) Ctrl + v    இ) Ctrl + x   ஈ) Ctrl + A 

3. லிதபர ்ஆபிஸ் ரரடட்ரிெ் எே்ேரன வரகைான பக்க அரைவுகள் உள்ளன?  

அ) 1   ஆ) 2    இ) 3   ஈ) 4  

4. திரரயிெ் ரூெர ்தேரிைாவிட்டாெ் __________ கிளிக் தைை்ை தவண்டுை்.  

அ) View → Ruler    ஆ) View → Task    இ) File → Save    ஈ) Edit → Paste 

5. ஆவணே்ரேை ்தைமிக்க தைனு பைன்படுகிறது.  

அ) File → Open     ஆ) File → Print     இ) File → Save   ஈ) File → Close  

II. கீழ்க்காணும் வினாக்களுக்கு விடடயளிக்கவும்  

1. உரர ஆவண தைன்தபாருளின் பைன்கள் ைாரவ? 

எழுே்ோற்றெ், புே்ேகங்கள், அறிக்ரககள், தைை்திைடெ்கள், ரகதைடுகள், ைற்றுை் பிற 

ஆவணங்கரளே் தோற்றுவிப்பேற்கு உரர ஆவணை் (Word தைைலி) பைன்படுகிறது.  

2. உரரரை தேரந்்தேடுே்ேெ் என்றாெ் என்ன? 

 உரரரை தேரந்்தேடுக்க சுட்டி அெ்ெது விரைப்பெரகரை பைன்படுே்ேொை்.  

 உரரகரள தேரந்்தேடுே்ே பின் தேரவைான ைாற்றங்கரள தைை்ைொை். 

 உரரரை நகரே்்ேவுை், நகெ் எடுக்கவுை், ேடிப்பாக்கவுை் முடியுை்.  

3. ஒரு ஆவணே்ரே எவ்வாறு  மூடொை்? 

ஒரு ஆவணே்திெ் தவரெ முடிந்ேவுடன் அந்ே தகாப்பிரன மூட  File → close என்ற 

கடட்ரை பைன்படுே்ேொை். 

4. வெது இரைவு என்பது என்ன? 

Word இெ் பே்திகரள வெதுபக்கை் ஒழுங்கு படுே்ேொை், அேனாெ் வெது பக்கை் 

ைைைச்ீராக இருக்குை். இது வெது இரைவு (Right Alignment) எனப்படுகிறது.  

5. ஏற்கனதவ உள்ள ஒரு ஆவணே்ரே திறப்பது எப்படி? 

www.Padasalai.Net                                                  www.TrbTnpsc.com
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தைமிக்கப்படட்ு மூடப்படட் ஒரு ஆவணே்ரே திறக்க, 

 தைனு படட்ியிெ் உள்ள திறந்ே தகாப்பு (Open) தபாே்ோரன அழுே்ேவுை்.  

 File →  Open என்ற கடட்ரளரை பைன்படுே்ேவுை்  

 விரைப்பெரகயிெ் Ctrl + O விரைகரள அழுே்ே திறந்ே உரரைாடெ் தபடட்ி தோன்றுை். 

தகாப்ரப தேரந்்தேடுே்து திறக்க (open) தபாே்ோரன அழுே்ேவுை். 
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